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Overview 
The Cobra 8.4 Cumulative Update 04 release includes all of the enhancements, software issues resolved, 
and database changes that were made in Cobra 8.4 CU 01 through CU 04. 

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact Deltek Customer Care at http://support.deltek.com before you install 
the update. 

 

Viewing the Online Help 
If you use Internet Explorer and the online help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove 
deltek.com (if listed) from the Websites you have added to Compatibility View list. You could also elect 
to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this 
issue. Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked 
content” when viewing the online help locally. The Cobra 8.4 Help System URL is 
https://help.deltek.com/Product/Cobra/8.4/GA. 

Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked content” 
when viewing the Cobra Online Help locally. This only affects Internet Explorer.  

You may also access the online help using Edge, Chrome, and Firefox. 

Attention: For steps to install the cumulative update, see Appendix A: Download and Install the 
Cumulative Update. 

http://support.deltek.com/
https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%208.0%20Help%20System.html
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Cobra 8.4 Cumulative Update 04 
Released: July 27, 2021 

Enhancements 

Update of the Cobra Web Services DLLs to Support the 64-Bit Web 
Service Client 
The following Cobra Web Service DLLs are updated to support the 64-bit Web Service client: 

 Cobra.Model.WebService.dll 

 Cobra.WebService.ClientAPI.dll 

Software Issues Resolved 

Codes » Code View 

Defect 487242 

Description: When you renamed a code in a code file, the parent field was not updated on the child 
codes of the renamed code. 

Customers Impacted: This defect affects customers who access a code file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration Wizard — Project Data 

Defect 1424062 

Description: When you ran the Integration Wizard on an n-tier deployment, the temporary files uploaded 
from the client were not deleted from the \Temp folder of the application server. 

Customers Impacted: This defect affects customers who run Cobra on an n-tier deployment. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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Defect 1476938 

Description: When you ran the Integration Wizard against a project with a large COSTELEM table, 
Cobra crashed. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Calculate Forecast 

Defect 1482037 

Description: When you ran the Calculate Forecast Wizard against a forecast class with PF= User Input 
forecast method, and whose forecast performance factor level was set to Control Account, Cobra did 
not populate the forecast classes with PF= User Input forecast method on the Manual Performance 
Factors page. 

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard on an 
Oracle database. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Replan 

Defect 945673 

Description: When you ran the Replan Wizard with the Create a new Work Package for the replanned 
Budget/Progress/Actuals option selected on the Options page and actual costs were set to be captured 
at the work package level, Cobra did not update the control account start date to encompass the new 
work package start date. 

Customers Impacted: This defect affects customers who use the Replan Wizard. 

Workaround Before Fix: Run the Validity Check Wizard with the Adjust Control Account dates to 
exactly span Work Package dates option selected on the Business Validations page. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Installation 
Guide 

 Removed “Microsoft Excel 365 (ProPlus)” from the Supported Deployment 
Technology table. 

Cobra 8.4 
Technical 
Overview and 
Systems 
Requirements 
Guide 

 Removed “Microsoft Excel 365 (ProPlus)” from the Supported Deployment 
Technology table. 

Cobra 8.4 Help   Updated the Cobra Button node to align the topics with the user interface. 

Cobra 8.4 
Cumulative 
Update 03 

 Removed Defect 945673. 

 

https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%20Button.html
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Cobra 8.4 Cumulative Update 03 
Released: May 28, 2021 

Enhancements 
There are no enhancements in this release. 

Software Issues Resolved 

Help 

Defect 1466116 

Description: The Concurrent Apportionment Calculations help topic incorrectly mentioned that running 
concurrent apportionment calculations will process 100 control accounts per batch instead of 30. 

Customers Impacted: This defect affects customers who access the Cobra Help System. 

Workaround Before Fix: None. 

Files Updated: 

 Concurrent Apportionment Calculations.html 

Defect 1464836 

Description: The File Selection Page of the Integration Wizard Actuals and Field Mapper Page of the 
Integration Wizard help topics contained references to XLS format even if it was not supported. 

Customers Impacted: This defect affects customers who access the Cobra Help System. 

Workaround Before Fix: None. 

Files Updated: 

 Field Mapper Page of the Integration Wizard.html 

 File Selection Page of the Integration Wizard Actuals.html 

Project Processes » Calculate Forecast 

Defect 1467347 

Description: When you ran the Calculate Forecast Wizard, Cobra encountered the "Arithmetic overflow" 
error on a Microsoft SQL Server database or the "Value larger than specified precision" error on an 
Oracle database in the following scenarios: 

 The Calculate Performance factors option on the Forecast Class Selection page was selected. 

 The forecast method of the forecast class was PF=1/CPI. 

 The Progress value to calculate CPI was close to zero (less than 0.005). 

 

Customers Impacted: This defect affects customers who use the Calculate Progress Wizard. 
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Workaround Before Fix: For the total Progress with values between 0.001 and 0.01, manually update 
the total Progress resource assignments to zero. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Replan 

Defect 1457065 

Description: When you ran the Replan Wizard on closed control accounts with actuals but without work 
packages and selected the Budget = Progress = Actuals option on the Method page, Cobra created two 
work packages with the same ID. 

Customers Impacted: This defect affects customers who use the Replan Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Online Help 

 Removed references to XLS format in the File Selection Page of the 
Integration Wizard Actuals and Field Mapper Page of the Integration Wizard 
help topics for Defect 1464836. 

 Updated the number of default control accounts per batch to 30 in the 
Concurrent Apportionment Calculations help topic for Defect 1466116. 

https://help.deltek.com/Product/Cobra/8.4/GA/File%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/File%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/Field%20Mapper%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Apportionment%20Calculations.html
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Cobra 8.4 Cumulative Update 02 
Released: May 06, 2021 

Enhancements 
There are no enhancements in this release. 

Software Issues Resolved 

Explorer View 

Defect 1443519  

Description: When you used the Save As function to create a copy of an ancillary file, Cobra 
encountered the "The field 'SEQUENCE' / property 'Sequence' for table WST_DIR does not exist in the 
data dictionary" error. 

Customers Impacted: This defect affects customers who upgraded from Cobra 8.2 or earlier version to 
Cobra 8.4 and who use the Save As function on an ancillary file. 

Workaround Before Fix: Export the ancillary file by running an export report and import it back with a 
new name using the Integration Wizard. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Cost Data Export 

Defect 1450704  

Description: When you ran the Cost Data Export process against a large project, the process completion 
took longer than expected. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData.dll 
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Defect 1454325  

Description: When you ran the Cost Data Export Wizard to generate the Integrated Program 
Management Data Analysis Report (IPMDAR) file, the ContractStartDate value in the generated file was 
incorrect. 

Customers Impacted: This defect affects customers who use the Cost Data Export process to generate 
the IPMDAR file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration wInsight 

Defect 1455256  

Description: When you ran the wInsight Export process to export a structure to the work package while 
actual costs were set to be captured at the control account level or both the control account and work 
package level and there were actuals in the past, Cobra encountered the "Must specify additional 
parameters. Procedure: addsinglepastperiod" error. 

Customers Impacted: This defect affects customers who use the wInsight Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 794947  

Description: When you ran the wInsight Export process against a master project but the calendar was 
not advanced at the master project level, Cobra displayed the "[Error] SQL Error calculating Baseline 
information" generic error message instead of a more descriptive one. 

Customers Impacted: This defect affects customers who use the wInsight Export process on a master 
project. 

Workaround Before Fix: Advance the calendar at the master project level. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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File » Integration Wizard — Project Data 

Defect 1453098  

Description: When you ran the Integration Wizard to load Open Plan data, Open Plan projects not 
shared with the WORLD or SYSADMIN group were not displayed in the Schedule Project Lookup dialog 
box even though the logged in user belonged to the SYSADMIN group. When you entered the name of 
the project in the Schedule Project field on the Project Selection page and clicked Next, Cobra displayed 
the "Invalid schedule project" error. 

Customers Impacted: This defect affects customers who use the Integration Wizard to integrate with 
Open Plan. 

Workaround Before Fix: Using Open Plan, share the project with the WORLD or SYSADMIN group. 

Files Updated:  

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1457593 

Description: When you ran the Integration Wizard, Cobra did not load all of the resource assignment 
codes. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load resource 
assignments codes. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1413609  

Description: When you ran the Integration Wizard, Cobra changed the baseline finish date to the first 
day of the status date period if: 

 The Apply historical budget changes as an adjusting entry in the current status period 
option on the Integration Wizard Preferences tab of the Project Properties dialog box was 
selected when loading budget that affected the Budget at Completion (BAC). 

 The baseline finish date was within the status period date range. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Installation 

Defect 1452828  

Description: When you ran the Cobra Database Upgrade Wizard to upgrade your database from version 
8.3 to 8.4, the InstallShield Wizard displayed the "Setup has detected a problem with the database 
upgrade" message even though the database version on the WST_PRD table was updated to 8.4. 

Customers Impacted: This defect affects customers who use the Cobra Database Upgrade Wizard. 

Workaround Before Fix: Upgrade your database from version 8.3 to 8.4 using the Cobra 8.4 installer. 

Files Updated: 

 DeltekCobra84DatabaseUpgradeWizard.exe 

Defect 1192442  

Description: When you installed Cobra on a MS SQL Server database, Cobra did not automatically run 
the Create or Upgrade scripts if TLS 1.0 was disabled. 

Customers Impacted: This defect affects customers who install Cobra on a Microsoft SQL Server 
database with TLS 1.0 disabled, regardless of the operating system. 

Workaround Before Fix: Do one of the following: 

 Enable TLS 1.0 in the registry. 

 Manually run the Create or Upgrade scripts for a MS SQL Server database. 

Additional Notes: Previously, the InstallShield Wizard displayed the following message if it detected that 
TLS 1.0 was disabled on the machine where you were installing Cobra: 

 

The Cobra installer now automatically executes the appropriate scripts and the following prerequisite 
software when it detects that you are using a MS SQL Server database: 

 Microsoft ODBC Driver 17.3 for Microsoft SQL Server Database  

 Microsoft Command Line Utilities 15 for Microsoft SQL Server Database 

See the Documentation Changes section for additional information. 

Files Updated: 

 DeltekCobra84.exe 
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Projects 

Defect 1453575  

Description: When you deleted or purged a project, related records on the LINK table and custom user 
tables were not deleted. 

Customers Impacted: This affects customers who use the Delete Project and Purge Project functions. 

Workaround Before Fix: Manually delete the orphaned records on the LINK table and custom user 
tables. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Project Processes » Freeze Forecast 

Defect 1455426 

Description: When you ran the Freeze Forecast and filtered by Control Account or Work Package with 
multiple control accounts or work packages selected on the Criteria page, Cobra added the existing 
forecast values to the second control account instead of copying the existing forecast values. 

Customers Impacted: This defect affects customers who use the Freeze Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Security 

Defect 1444613  

Description: When you launched EPM Security Administrator to define permissions for a role, the Allow 
loading forecast in the current status period option was not displayed in the Projects » Project 
Properties » Preferences tab » Integration Wizard node. 

Customers Impacted: This defect affects customers who upgrade to Cobra 8.4 GA or Cobra 8.4 CU01 
on a Microsoft SQL Server database and use EPM SA. 

Workaround Before Fix: Run the following script: 

"UPDATE WST_PFG 

 SET PFG_ID = '06.05.10.05.03' 

 WHERE PRD_UID = 600 AND PFG_UID = '60236' 

 AND PFG_ID != '06.05.10.05.03'" 
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Additional Notes: This defect is not encountered when performing a new installation of Cobra 8.4 GA or 
Cobra 8.4 Cumulative Update 01. 

Files Updated: 

 Cobra84_Upgrade_SqlServer.sql 

Tools » Validity Check 

Defect 1459309 

Description: When you ran the Validity Check process, Cobra displayed the following warning message: 
"[Warning] The project log differs from the budget detail. Run Reconcile in Project Audit to align the log 
with the budget detail." If you followed the steps to reconcile the project log using the Project Audit Wizard 
and then ran the Validity Check process again, Cobra displayed the same warning message. 

Customers Impacted: This defect affects customers who run the Validity Check process. 

Workaround Before Fix: None. 

Additional Notes:  

 This issue only occurs if the audit log contains values that differ from the time-phased data by > 
10c when summed over the entire project. 

 This issue does not occur if you select the Round audit log transactions to 6 decimal places 
option on the Other tab of the Application Preferences dialog box. 

 Once this fix is applied, Cobra may display the following different warning message when you run 
the Validity Check process: "[Warning] The project log disagrees with the project header. Open 
Project Audit to align the header values." Follow the steps to open the Project Audit Wizard to 
resolve the warning message. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
When upgrading from Cobra 8.4 GA or Cobra 8.4 Cumulative Update 01 to Cobra 8.4 Cumulative 02, the 
Upgrade Installation Wizard displays the Setup Type page and prompts you to select a database upgrade 
script option.  
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This step is needed to apply the fix for Defect 1444613, which corrects the data on the WST_PFG table. 

 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Installation 
Guide 

 Made the following updates for Defect 1192442. 

 Added the following items to the Supported Deployment Technology » 
Embedded Technologies table: 

 Microsoft ODBC Driver 17.3 for Microsoft SQL Server Database  

 Microsoft Command Line Utilities 15 for Microsoft SQL Server 
Database 

 Removed instances of the following note: 

 

 Added bullets 2 and 3 to the following note: 

 

Note: This is only a data change and not a database structure change. 
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Document Details 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added the following items to the Supported Deployment Technology » Embedded 
Technologies table for Defect 1192442: 

 Microsoft ODBC Driver 17.3 for Microsoft SQL Server Database  

 Microsoft Command Line Utilities 15 for Microsoft SQL Server Database 
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Cobra 8.4 Cumulative Update 01 
Released: March 26, 2021 

Enhancements 

Use a Replanned Class as a Target Class During Reclass Through the 
Cobra Web Service 
When you run the Reclass process through the Cobra Web Service, you can now use a Replanned class 
as a Target class if the Source class is a Budget class (included or not-included). 

 

Software Issues Resolved 

API » PMC Web Services 

Defect 1325684 

Description: When you ran the Replan Wizard against a project with actual costs at the control account 
level or both the control account and work package level, and selected the Create a new Work Package 
for the replanned Budget/Progress/Actuals and the Allow completed Work Package to be 
replanned options on the Options page and the Budget = Progress = Actuals option on the Method 
page, Cobra created a duplicate work package incorrectly if you entered a work package prefix of an 
existing work package. 

Customers Impacted: This defect affects customers who use the Replan process on projects with 
actuals costs at the control account level or both control account and work package level. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WInUI.*.dll 

API » Web Services 

Defect 1412670  

Description: The Cobra Web Service did not support the Scale Retain EAC value of None and instead 
used Currency as the default value. 

Customers Impacted. This defect affects customers who run the Calculate Forecast process through the 
Cobra Web Service. 

Workaround Before Fix: None. 

Attention: For more information on the Reclass process through the Cobra Web Service, see the 
Web Service Client API Help. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_WebService_ClientAPI_Application_Files_ReclassServiceArguments.htm
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Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Model.WebService.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

 Cobra.Api.exe 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

 Cobra.WebSerivce.ClientAPI.dll 

Defect 1413792  

Description: When you ran a report that did not support roll up results through the Cobra Web Service, 
you encountered the "The Results criteria must be selected as the last sub-total criteria" error  and the roll 
up results were incorrectly validated if the RollupResults parameter on the Report Definition tab of the 
Report Properties dialog box was set to 1. When you ran a report through the Report Wizard, you also 
encountered the same error if the AllowSelectCriteria parameter was set to 1. 

Customers Impacted. This defect affects customers who generate reports. 

Workaround Before Fix: None. 

Additional Notes: Roll-up results are only supported in CrossTab and Summary report types. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Model.WebService.dll 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

Codes » Code View 

Defect 1437008  

Description: When you deleted a code from the code file and then added a new code, the tag of the last 
code from the code file was duplicated on the newly created code.  

Customers Impacted: This defect affects customers who access a code file. 

Workaround Before Fix: Rebuild the code file hierarchy. 

Additional Notes: This issue is also encountered when accessing a resource file. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 
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 Cobra.Model.LoginManager.dll 

File » Integration Cost Data Export 

Defect 1434970  

Description: When you ran the Cost Data Wizard and selected the Use WBS/OBS combination as 
Control Account option on the Data Options page, the description in the exported cost data file was not 
the WBS/OBS description. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData.dll 

File » Integration Wizard — Project Data 

Defect 1429047  

Description: When you ran the Integration Wizard to load percent complete values from Open Plan and 
there were many activities in one work package, Cobra loaded the incorrect percent complete values. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load percent 
complete values from Open Plan. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1434811  

Description: When you ran the Integration Wizard to load only budget resources and the project 
contained a forecast class with a prefix of the budget class ID being imported, Cobra did not load the 
resource assignments. 

Customers Impacted: This defect affects customers who load resource assignments using the 
Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 
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 Cobra.Process.dll 

Defect 1434917  

Description: When you ran the Integration Wizard, Cobra encountered an error about not having enough 
memory to complete the operation in any of following conditions: 

 The integration was run against a project with a large number of time-phased data. 

 The data loaded was filtered by a specific budget or class. 

 The Delete items from Cobra that are no longer in the schedule option on the Change Control 
page was selected. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1433513 

Description: When you ran the Integration Wizard to load resource assignments, resource assignments 
with similar names did not use the correct rate set. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Run the Recalc Wizard. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Projects » Project Information 

Defect 394418  

Description: When you copied an earned class, Cobra did not copy the Include in Progress information 
to the target project. 

Customers Impacted: This defect affects customers who copy classes. 

Workaround Before Fix: Manually add the new class to the Progress cost set. 

Additional Notes: This issue is also encountered when copying a forecast class. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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Projects » Project View 

Defect 1424171  

Description: When you used the Move Work Package function, the control account was successfully 
moved to the selected target project but the time-phased records of the first control account listed in the 
source project got deleted. 

Customers Impacted: This defect affects customers who use the Move Work Package function. 

Workaround Before Fix: Use the Copy To function instead of the Move Work Package function. After the 
copy process completes, manually delete the control account. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Reports » Report Information 

Defect 1434993  

Description: When you selected another user who already owned a report with the same name in the 
Owner field on the Access Control tab of the Report Properties dialog box, Cobra did not allow you to 
save the changes but did not display an error message. 

Customers Impacted: This defect affects customers who use the Report Properties dialog box. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Resources.dll 

Security 

Defect 1432012  

Description: When you edited any details of a project on the Project Properties dialog box, Cobra 
required user access to the calendar used by the project. 

Customers Impacted: This defect affects customers who access the Project Properties dialog box. 

Workaround Before Fix: Provide access to the calendar file used by the project. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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 Cobra.Resources.dll 

Tools » Validity Check 

Defect 1425308  

Description: When you ran the Validity Check Wizard against a project that contained a control account 
with In progress status but all of the work packages associated with it have Planned or Completed status, 
and selected the Business validations » Adjust Control Account dates to exactly span Work 
Package dates option on the Business Validations page, Cobra crashed with the " Unhandled Exception: 
Nullable object must have a value" error. 

Customers Impacted: This defect affects customers who use the Validity Check Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Online Help 

 Added a note about using a replanned class as a target class when running 
the Reclass process through the Cobra Web Service in the Target Class Page 
of the Reclass Wizard help topic. 

 

https://help.deltek.com/Product/Cobra/8.4/GA/Target%20Class%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Target%20Class%20Page%20of%20the%20Reclass%20Wizard.html
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Appendix A: Download and Install the 
Cumulative Update  

Download the Cumulative Update 
1. From Internet Explorer, go to https://dsm.deltek.com.  

2. Click Run Deltek Software Manager.  

3. Log in using your Deltek Customer Care Connect credentials.  

4. In the left pane of the Deltek Software Manager, expand your Deltek product.  

5. Expand the Cumulative Updates folder for your product, and select the update to download.  

6. Click Download at the bottom of the screen. 

Install the Cumulative Update 
Use the instructions below that apply to the Cobra version you use. 

 

For Cobra 8.x and Higher 
The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. Use 
the instructions below that apply to your deployment scenario. 

 

If You Use a Deployment Server 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 

https://dsm.deltek.com/
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6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish.  

7. Launch the Deltek Cobra shortcut on client workstations to initiate the update. 

To install on a client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. When the installation 
is completed, the installation wizard closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have an N-Tier Deployment 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update. 

To install on an n-tier client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. If you choose Yes, 
the installation wizard copies the updated DeltekCobraWorkstation.exe file locally and 
automatically begins installing files. When the installation is completed, the installation wizard 
closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have a Terminal Services/Citrix Deployment 

To install on the deployment server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Log on as a Local Administrator on the Terminal Server/Application Server and install the update. 

To install on the Terminal Server/ Application Server (the server on which the Cobra client runs): 

1. Log on to the Terminal Server using an account that has Local Administrator privileges. When the 
setup launches, the installation program installs all necessary files and any registry updates and 
makes these changes available to all users who will subsequently log on to the Terminal Server 
session to run Cobra.  

2. Ensure that no instance of Cobra is running.  

3. Browse to the shared Cobra Workstation folder (usually located on the deployment server, as 
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).  

4. Launch the DeltekCobraWorkstation.exe file to install the update. The Welcome screen displays, 
showing that the update is available.  

5. Click Next to start the installation.  

6. When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm 
that the update is installed, meaning that users can now launch Cobra via Terminal 
Services/Citrix sessions. 

If You Have a Standalone Deployment 

To install on the workstation: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut to log into Cobra. 

Confirm that the Cumulative Update is Installed 

1. Click  » Help » About Deltek Cobra. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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2. Check that the version number reflects the installation of the update. 
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Appendix B: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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